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Simulink Real-Time Product Description
Build, run, and test real-time applications

Simulink Real-Time lets you create real-time applications from Simulink models and run
them on dedicated Speedgoat target computer hardware connected to your physical
system. It supports real-time simulation and testing, including rapid control prototyping,
DSP and vision system prototyping, and hardware-in-the-loop (HIL) simulation.

With Simulink Real-Time you can extend your Simulink models with driver blocks,
automatically generate real-time applications, define instrumentation, and perform
interactive or automated runs on a dedicated target computer equipped with a real-time
kernel, multicore CPU, I/O and protocol interfaces, and FPGAs.

Simulink Real-Time and Speedgoat target computer hardware are expressly designed to
work together to create real-time systems for desktop, lab, and field environments.

Key Features
• Automatic generation of real-time applications from Simulink models targeting

dedicated CPUs, I/O and protocol hardware, and FPGAs (with HDL Coder™)
• Multitasking and multicore real-time kernel with microsecond granularity and

concurrent execution support
• Speedgoat target computer hardware integration for turnkey desktop, lab, and field

use
• Driver blocks for I/O, including analog, digital, pulse train, encoders, transformers,

passive components, serial, audio, shared memory, and reconfigurable FPGA
• Driver blocks for protocols and data buses, including Raw Ethernet, real-time UDP,

CAN, EtherCAT®, Ethernet/IP, Lin, SAE J1939, FlexRay™, Camera Link®, USB video,
ARINC 429, and MIL-STD-1553

• Simulink Real-Time Explorer with gigabit Ethernet connection to multiple target
computers for management, execution, and instrumentation of real-time applications

• Standalone operation of real-time applications with high-resolution signal display
• MATLAB® functions for test scripting, and APIs for developing standalone client

applications and user interfaces (Visual Basic®, C/C++, Java®, and .NET)

1 Introduction
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Alternative Configuration and Control Methods
The Simulink Real-Time environment has a modifiable interface to the target computer.
You can use this interface from MATLAB or Simulink, and you can use other development
environments to create custom standalone client applications independent of MATLAB.
Because of this open environment, there are several ways to interact with your real-time
application from the development and target computers.

The following table compares the interfaces supported by the Simulink Real-Time
product.

Interface Environment
Properties

Control Signal
Acquisition

Parameter
Tuning

Runnable
Outside
MATLAB

Simulink
Real-Time
Explorer

X X X X X

“MATLAB
Command-Line
Interface” on
page 1-5

X X X X  

“Simulink
External Mode
Interface” on
page 1-7

 X X X  

“Simulink with
Simulink Real-
Time Blocks”
on page 1-8

  X   

“Target
Computer
Command-Line
Interface” on
page 1-9

 X X X X

 Alternative Configuration and Control Methods
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Interface Environment
Properties

Control Signal
Acquisition

Parameter
Tuning

Runnable
Outside
MATLAB

“Explorer
Configuration
Exported to
Run Outside
MATLAB”

 X X X X

“Deploy
MATLAB
Application to
Control Real-
Time
Application”

 X X X X

“Custom UI
with Simulink
Real-Time API
for
Microsoft .NET
Framework” on
page 1-10

 X X X X

“Custom UI
with Simulink
Real-Time C
API” on page 1-
11

 X X X X

1 Introduction
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MATLAB Command-Line Interface
You can interact with the Simulink Real-Time environment through the MATLAB
command-line interface. Enter Simulink Real-Time functions in the MATLAB window on
the development computer. You can also write your own MATLAB scripts that use
Simulink Real-Time functions for batch processing.

The Simulink Real-Time software has more than 90 MATLAB functions for controlling the
real-time application from the development computer. These functions define, at the most
basic level, what you can do with the Simulink Real-Time environment.

The GUIs provided with the Simulink Real-Time product are for completing the most
common tasks. They use the Simulink Real-Time functions but do not extend their
functionality. The command-line interface provides an interactive environment that you
can extend.

The MATLAB command-line interface includes the following functions:

• Environment — Create a target boot kernel and directly change the environment
properties without using a graphical interface.

• Control — Restart the target computer, download a real-time application, start the
real-time application, change start and sample times without regenerating code, and
stop the real-time application. Record task execution time during or after the last run.
Add and remove scopes, add/remove signals to scopes, and define triggers for scope
display.

• Signal acquisition — Trace signals for viewing while the real-time application is
running and monitor signal values without time information. Transfer logged signal
data to the MATLAB workspace by uploading from the target computer to the
development computer between runs. For standalone target computers, if you write
signal data to a file, use SimulinkRealTime.fileSystem functions to copy that file
to the development computer.

• Parameter tuning — Change tunable block parameters and tunable global parameters
while the real-time application is running, and use Simulink Real-Time functions to
change parameters in between runs.

For more information, see:

• “Command-Line PCI Bus Ethernet Setup” or “Command-Line USB-to-Ethernet Setup”
• “Command-Line Target Computer Settings”

 MATLAB Command-Line Interface
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• “Command-Line Target Computer Boot Methods”
• “Execute Real-Time Application with MATLAB Language” on page 4-35.
• “Monitor Signals with MATLAB Language”
• “Configure Target Scopes with MATLAB Language”
• “Configure File Scopes with MATLAB Language”
• “Log Signal Data with Outport Block and MATLAB Language”.
• “Tune Parameters with MATLAB Language”.

1 Introduction
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Simulink External Mode Interface
Use Simulink in external mode to connect your Simulink block diagram to your real-time
application. The block diagram becomes a user interface to the real-time application. By
changing parameters in the Simulink blocks, you also change parameters in the real-time
application.

The Simulink external mode interface includes the following functions:

• Control — Control is limited to connecting the Simulink block diagram to the real-time
application, and starting and stopping the real-time application.

• Signal acquisition — You can use Simulink external mode to establish a communication
channel between your Simulink block diagram and your real-time application. The
block diagram becomes a user interface to your real-time application and Simulink
scopes can acquire signal data from the real-time application.

• Parameter tuning — Specify external mode, and change parameters in the real-time
application by changing parameters in the Block Parameters dialog boxes. When you
change a value and click OK, the new value is downloaded to the target computer
while the real-time application continues to run.

For more information, see:

• “Execute Real-Time Application with Simulink External Mode” on page 4-19
• “Trace Signals with Simulink External Mode”.
• “Tune Parameters with Simulink External Mode”.

 Simulink External Mode Interface
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Simulink with Simulink Real-Time Blocks
An alternative to interactively adding scopes to the target computer is to add Simulink
Real-Time Scope blocks to your Simulink model. After the download process, these blocks
create scopes on the target computer during initialization of the real-time application. You
can display data on either the development computer or target computer. You can also
save signal data (log real-time data stream) to a file in the target computer file system
and transfer that file to another computer. Finally, you can use To and From blocks to
transfer data to and from a Simulink user interface model.

Signal acquisition — Add scopes to the target computer by adding Simulink Real-Time
Scope blocks to your Simulink model. In the Block Parameters dialog box, select the
scope mode and set the trigger.

For information on acquiring signal data with Scope blocks, see:

• “Add Simulink Real-Time Scope Block” on page 4-8
• “Set Target Scope Block Parameters” on page 4-9
• “Signal Tracing Basics”

For information on using Simulink Real-Time To and From blocks to transfer data to and
from a Simulink user interface model, see “Simulink Real-Time Interface Blocks to
Simulink Models”.

1 Introduction
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Target Computer Command-Line Interface
You can interact with the Simulink Real-Time environment through the target computer
command window. Enter commands in the command line on the target computer. This
interface is useful with standalone real-time applications that are not connected to the
development computer.

The target computer command-line interface includes the following functions:

• Control — Start and stop the real-time application, and change the stop time and
sample time.

• Signal acquisition — Acquiring signal data is limited to viewing signal traces and
signal monitoring on the target computer screen.

• Parameter tuning — You can change only scalar parameters in your model.

For more information, see “Control Real-Time Application at Target Computer Command
Line”.

 Target Computer Command-Line Interface
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Custom UI with Simulink Real-Time API for
Microsoft .NET Framework

Use the .NET API Simulink Real-Time framework to develop custom applications such as
human-machine interface (HMI) software and batch run scripts that use the Simulink
Real-Time software. The Simulink Real-Time .NET object model provides objects that you
can interact with. The Simulink Real-Time software arranges the Simulink Real-
Time .NET objects in a hierarchical order. Each of these objects has methods and
properties that allow you to manipulate and interact with it. This document presents this
reference using the C# language.

For more information, see “Using the Simulink Real-Time API for Microsoft .NET
Framework”.

1 Introduction
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Custom UI with Simulink Real-Time C API
Use the C API to create a user interface to a real-time application using a development
environment that can link in a DLL.

Use the user interface application to control the real-time application, tune parameters,
and acquire signal data. The custom user interface runs on the development computer
and communicates with the real-time application on the target computer using TCP/IP
communication. A user interface application can be a console or Windows® application
using ActiveX® components.

For more information, see “Using the C API”.

 Custom UI with Simulink Real-Time C API
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Installation and Configuration

• “Development Computer Setup and Configuration” on page 2-2
• “Target Computer Setup and Configuration” on page 2-3
• “Development Computer Requirements” on page 2-4
• “Development Computer Communication Setup” on page 2-6
• “Development Computer Software Installation” on page 2-7
• “PCI Bus Ethernet Setup” on page 2-9
• “USB-to-Ethernet Setup” on page 2-12
• “Target Computer Settings” on page 2-13
• “Target Computer Boot Methods” on page 2-15
• “CD/DVD Boot Method” on page 2-16
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• “Removable Disk Boot Method” on page 2-21
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Development Computer Setup and Configuration
The setup and configuration steps for using Simulink Real-Timeon your development
computer are:

• “Development Computer Requirements” on page 2-4
• “Development Computer Communication Setup” on page 2-6
• “Development Computer Software Installation” on page 2-7
• “Command-Line C Compiler Configuration”

2 Installation and Configuration
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Target Computer Setup and Configuration
The setup and configuration steps for using Simulink Real-Timeon your target computer
are:

1 “PCI Bus Ethernet Setup” on page 2-9
2 “Target Computer Settings” on page 2-13
3 “Target Computer Boot Methods” on page 2-15

To check out the setup, see “Run Confidence Test on Configuration” on page 2-29.

For more information about target computers, see “Speedgoat Target Computers and
Support”.

 Target Computer Setup and Configuration
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Development Computer Requirements
To install and run Simulink Real-Time, MATLAB, Simulink, and other required and
optional software, the development computer must be a 64-bit PC-compatible system with
Microsoft® .NET Framework 4.5 or later installed. See Installing the .NET
Framework (msdn.microsoft.com/en-us/library/5a4x27ek(v=vs.110).aspx).

In the Simulink Real-Time software environment, the development computer is usually
your desktop computer. A notebook computer is also a viable development computer.

Peripherals
To install and run the Simulink Real-Time product, the development computer requires
one hard disk drive with 60 MB of free space.

For producing target computer boot media, the development computer requires one or
more of:

• CD-RW drive or DVD-RW drive.
• USB drive (Universal Serial Bus drive).

You can use a USB drive as a removable boot drive and for data transfer to and from
the target computer. For data storage, Simulink Real-Time supports 1-LUN (logical
unit) USB drives, 2-LUN USB drives, and 4-LUN card readers.

• SD (Compact) flash drive.
• Removable hard drive.
• 3.5-inch floppy disk drive.

Communication with Target Computer
For communicating with the target computer, the development computer requires one
available Ethernet interface (PCI or USB) connected to a network. Configure the
development computer Ethernet port to use Internet Protocol Version 4 (TCP/IPv4) only.
Specify a nonroutable static IP address of the form 10.x.x.x.

2 Installation and Configuration
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See Also

More About
• “Development Computer Communication Setup” on page 2-6
• “PCI Bus Ethernet Setup” on page 2-9

External Websites
• www.microsoft.com

 See Also

2-5

https://www.microsoft.com


Development Computer Communication Setup
To communicate with the target computer using Ethernet, perform a one-time
configuration of your development computer Ethernet port to use Internet Protocol
Version 4 (TCP/IPv4) only. Specify a nonroutable static IP address of the form 10.x.x.x:

1 On your development computer, from the Control Panel, navigate to Network and
Sharing Center.

2 Click the Local Area Connection for the Ethernet adapter you are using. It is most
likely listed as Unidentified network.

3 Click the Properties button.
4 In the Networking pane, clear all check boxes.
5 Select the Internet Protocol Version 4 (TCP/IPv4) check box.
6 Click the Properties button.
7 To specify a static IP address of the form 10.x.x.x, select the Use the following IP

address check box.
8 Configure the IP address boxes as follows:

IP address — 10.10.10.100

Subnet mask — 255.255.255.0

Default gateway — leave blank
9 Click the OK button.

2 Installation and Configuration
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Development Computer Software Installation
You install the Simulink Real-Time software only on the development computer. The
development computer downloads the kernel software and real-time application to the
target computer at run time. The Simulink Real-Time software is distributed on a DVD or
as a file you download from the Internet.

Check that you have met the following requirements:

• You must have uninstalled prior installations of the Simulink Real-Time product.
• You must have a valid license for the required products. See “License Requirements”

on page 2-7.
• You must have Microsoft .NET Framework 4.5 or later installed on the development

computer. If the framework is not installed, the installation software prints an error
message. See Installing the .NET Framework (msdn.microsoft.com/en-us/
library/5a4x27ek(v=vs.110).aspx).

• You must have a Microsoft C compiler installed on the development computer.

Note By default, the Microsoft Visual Studio® 2015 installer does not install the C++
compiler that Simulink Real-Time requires. To install the C++ compiler, perform a
custom install and select the C++ compiler. If you already installed Microsoft Visual
Studio with the default configuration, rerun the installer and select the modify option.

See “Command-Line C Compiler Configuration”.

For more information about the file structure after installation, including the location of
examples, see “Location of Files on the Development Computer” on page 2-8.

License Requirements
Before you install the Simulink Real-Time product, you must have a valid File Installation
Key and License File. The File Installation Key identifies the products that you purchased
from MathWorks®. The License File activates the installation.

If you have not received either of these items, go to the License Center at the MathWorks
website.

 Development Computer Software Installation
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Simulink Real-Time includes standalone mode. With standalone mode, you can create
standalone real-time applications that run separate from the development computer.

Location of Files on the Development Computer
Files are located in the:

• MATLAB working folder — Simulink models (model), Simulink Real-Time applications
(model.mldatx)

Select a working folder outside the MATLAB root.
• Simulink Coder™ Build folder — The Simulink Coder C code files (model.c, model.h)

are in a subfolder called modelname_xpc_rtw.

The Simulink Real-Time software uses files located under these folders:

• matlabroot\toolbox\slrt\

• blocks — Drivers and associated blocks
• slrt — Development computer functions related to the Simulink Real-Time

software, methods for target objects, and methods for scope objects
• slrtexamples — Simulink models and MATLAB code examples

• matlabroot\toolbox\rtw\targets\xpc\

• target — Files and functions related to the Simulink Real-Time kernel and build
process, including drivers to support I/O blocks

• xpc — Development computer functions related to the Simulink Real-Time
software, methods for target objects, and methods for scope objects

• xpcdemos — Simulink models and MATLAB code examples

See Also

External Websites
• www.microsoft.com
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PCI Bus Ethernet Setup
Speedgoat target machines include an onboard (PCI bus) Ethernet controller. The PCI bus
and slot information for the Ethernet controllers are available in the Speedgoat
documentation. To get a list of these Ethernet cards, in the Command Window, type:

tg = slrt;
getPCIInfo(tg, 'ethernet')

To build and download a real-time application, first specify the environment properties for
the development and target computers.

1 Ask your system administrator for the following information for your target
computer:

• IP address
• Subnet mask address
• Port number (optional)
• Gateway (optional)

2 In the MATLAB Command Window, type slrtexplr.
3 In the Targets pane, expand the target computer node.
4 On the toolbar, click the Target Properties button .

• To add a node representing another target computer, in the Targets pane, click
the Add Target button .

• To remove a node representing a target computer, right-click the node and select
Remove.

5 In the Target Properties pane, click Host-to-Target communication.
6 Set IP address to the IP address for your target computer (for example, Speedgoat

target machines are preconfigured to address 192.168.7.1).
7 Set Subnet mask to the subnet mask address of your LAN (for example,

255.255.255.0).
8 Set Port (optional) to a value greater than 20000 and less than 65536. This property

is set by default to 22222, a value higher than the reserved area (telnet, ftp, and
so on).

9 If a gateway is required, set Gateway (optional) to the gateway required to access
the target computer. This property is set by default to 255.255.255.255, which
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means that you do not use a gateway to connect to your target computer. If you
connect your computers with a crossover cable, leave this property as
255.255.255.255.

If you communicate with the target computer from within your LAN, do not change
the default setting. If you communicate from a development computer within a LAN
different from your target computer, define a gateway and enter its IP address here.
In particular, create a gateway if you access the target computer via the Internet.

10 Select Bus type PCI.

Note: All Speedgoat target machines use bus type PCI.
11 For Target driver Auto (default).

Note: This setting depends on type of Speedgoat target machine. The information is
provided in the Speedgoat documentation and is available in the label attached to the
target machine.

12 If the target computer has multiple Ethernet cards, see the Speedgoat documentation
and “Ethernet Card Selection by Index”.

13
Press Enter, then click the Save button  on the toolbar.

The Simulink Real-Time Explorer window looks like this figure.
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Repeat this procedure as required for each target computer.

See Also
getPCIInfo

More About
• “Ethernet Card Selection by Index”
• “Command-Line Ethernet Card Selection by Index”
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USB-to-Ethernet Setup
This feature does not apply for Speedgoat target machines.

See Also
getPCIInfo

More About
• “Ethernet Card Selection by Index”
• “Command-Line Ethernet Card Selection by Index”
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Target Computer Settings
To run a Simulink Real-Time model on a target computer, you must configure the target
settings to match the capabilities of the target computer.

Note

• In a future release, the SecondaryIDE target setting will be read-only and set to
'off'.

• The MulticoreSupport target setting is read-only and set to 'on'.
• The MaxModelSize property has no function.
• The RAM size check box has been removed from Simulink Real-Time Explorer. The

TargetRAMSizeMB property value continues to function.

1 In the MATLAB Command Window, type slrtexplr.
2 In the Targets pane, expand the target computer node.
3 On the toolbar, click the Properties button .
4 In the Target Properties workspace, click Target settings.
5 Execute the following target computer settings as required:

• USB Support — If you want to use a USB port on the target computer; for
example, to connect a USB keyboard, leave this check box selected. Otherwise,
clear it.

• Multicore CPU — The MulticoreSupport target setting is read-only and set to
'on'.

Note: Obsolete setting. Leave this check box selected.
• Graphics mode — If you want to display information, such as a target scope, in

graphic format, leave this check box selected. If you want to display information
as text, clear it.

6
Press Enter, then click the Save button  on the toolbar.

The Simulink Real-Time Explorer window looks like this figure.
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Repeat this procedure as required for each target computer.
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Target Computer Boot Methods
You can start your target computer with the Simulink Real-Time kernel using one of
several methods.

Speedgoat systems come with DOS Loader software preinstalled. You can set up the DOS
Loader boot method on your development computer or configure another boot method.
See your Speedgoat system documentation or follow the link from “Speedgoat Target
Computers and Support” for further information.

1 Select one of the following methods:

• “Network Boot Method” on page 2-17
• CD/DVD Boot Method - does not apply for Speedgoat target machines
• “DOS Loader Boot Method” on page 2-22
• Removable Disk Boot Method - does not apply for Speedgoat target machines
• “Standalone Boot Method” on page 2-23

2 For boot methods other than Stand Alone, perform “Run Confidence Test on
Configuration” on page 2-29.

For boot method Stand Alone, create a model-specific confidence test, restart the
target computer, and run that confidence test. The default confidence test is not
intended for standalone execution.
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CD/DVD Boot Method
This feature does not apply for Speedgoat target machines.
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Network Boot Method
After you have configured the target computer environment parameters, you can use a
dedicated Ethernet network to load and run the Simulink Real-Time kernel.

The network boot method limitations include:

• Do not use the network boot method on a corporate or nondedicated network. Doing
so can interfere with dynamic host configuration protocol (DHCP) servers and cause
problems with the network.

• Your Speedgoat target machine must be compatible with the Preboot eXecution
Environment (PXE) specification. See Speedgoat documentation.

• If Boot mode Stand Alone is enabled, you cannot start the target computer across
the network.

Before you start, establish an Ethernet connection between the development and target
computers, using the procedures in “PCI Bus Ethernet Setup” on page 2-9.

1 In the MATLAB Command Window, type slrtexplr.
2 In the Targets pane, expand the target computer node.
3 On the toolbar, click the Target Properties button .
4 Select Boot configuration and set Boot mode to Network.
5 To clear the MAC address, click Reset.

If you clear the MAC address, the next time the target computer starts, by default,
the software automatically obtains the MAC addresses of accessible target
computers. The software displays them for confirmation in the Simulink Real-Time
Network Boot dialog box.

6 To enter the MAC address of the target computer manually, click Reset. In the MAC
address box, enter the address in the format xx:xx:xx:xx:xx:xx.

The next time the target computer starts, the software selects and starts the target
computer that matches this MAC address. The Simulink Real-Time Network Boot
dialog box does not open.

7 Click Create boot disk.
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The software creates and starts a network boot server process on the development
computer. You see a minimized icon ( ) in the bottom right system tray on the
development computer.

8 Turn on the target computer.
9 Enter the target computer BIOS and set up the target computer for a LAN or network

boot.

If the BIOS allows you to change the boot order, consider setting the boot order so
that the boot drive comes before the LAN option. Then you can start the target
computer from a network kernel even if the target computer does not have a kernel
boot disk or removable drive.

10 Restart the target computer.
11 The first time the network boot server process detects a target computer, it displays

the Simulink Real-Time Network Boot dialog box. This dialog box contains physical
target computer names and the corresponding IP addresses.
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a Select the target computer name for the physical target computer.
b Click OK.

The development computer network boot server displays a message indicating that
the boot server is being downloaded to the target computer.
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If you click Cancel, the kernel waits for 90 seconds before responding the next time
you try to start the target computer across the network.

12
Press Enter, then click the Save button  on the toolbar.

The Simulink Real-Time Explorer window looks like this figure.

Repeat this procedure as required for each target computer.

Tip To configure network boot using MATLAB language, see “Command-Line Network
Boot Method”.

The next task is “Run Confidence Test on Configuration” on page 2-29.
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Removable Disk Boot Method
This feature does not apply for Speedgoat target machines.
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DOS Loader Boot Method
In DOS Loader mode, you start the Simulink Real-Time kernel on a Speedgoat target
machine from the preinstalled solid state drive or hybrid hard drive with DOS boot
capability. After starting the target computer, you can download your real-time application
from the development computer over a connection between the development and target
computers.

Speedgoat systems come with DOS Loader software preinstalled. You can set up the DOS
Loader boot method on your development computer or configure another boot method.
See your Speedgoat system documentation or follow the link from “Speedgoat Target
Computers and Support” for further information.
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Standalone Boot Method
You can configure the Simulink Real-Time software to run as a standalone real-time
application on your Speedgoat target machine. For more information on Boot mode
Stand Alone, see “Standalone Mode” on page 2-27.

Standalone Settings

Note Speedgoat target machines come with DOS Loader software preinstalled.

You can set up the DOS Loader boot method on your development computer or configure
another boot method.

For more information about booting and kernel transfer, see your Speedgoat target
machine documentation or follow the link from “Speedgoat Target Computers and
Support”.

Use Simulink Real-Time Explorer to set the kernel environment properties. When you are
done, you can create a standalone kernel and real-time application.

For Boot mode Stand Alone, you do not create a Simulink Real-Time boot disk or
network boot image. Instead, you copy files created from the build process to the target
computer hard drive.

1 In the MATLAB Command Window, type slrtexplr.
2 In the Targets pane, expand the target computer node.
3 On the toolbar, click the Target Properties button .
4 Select Boot configuration and set Boot mode to Stand Alone. Also, check the

host-target communications settings, which correspond to the Speedgoat target
machine. See “PCI Bus Ethernet Setup” on page 2-9.

5
Press Enter, then click the Save button  on the toolbar.

Repeat this procedure as required for each target computer.
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Real-Time Application Build
After you set Simulink Real-Time boot mode to Stand Alone, you can use Simulink Real-
Time, Simulink Coder, and a C/C++ compiler in Stand Alone mode to build a
standalone kernel and real-time application with utility files.

1 In the Command Window, open your Simulink model, for example, ex_slrt_rt_osc
(open_system(docpath(fullfile(docroot, 'toolbox', 'xpc',
'examples', 'ex_slrt_rt_osc')))). Simulink Editor opens displaying the
model.

2 From the Code menu, click C/C++ Code > Build Model.

The Simulink Coder and Simulink Real-Time software create a folder,
ex_slrt_rt_osc_slrt_emb, containing the files that boot the target computer and
run the real-time application.

Repeat this procedure as required for each real-time application.

Real-Time Application Transfer and Boot Configuration
After building the kernel and real-time application on a development computer, transfer
the files to a target computer by using the SimulinkRealTime.fileSystem object
functions. Configure the target computer to run the real-time application upon startup.

For this procedure, your target computer must support network boot mode. If it does not
support network boot mode, see “Application Transfer and Boot Configuration with Flash
Drive” on page 2-25.

1 Restart the target computer in DOS mode and open the DOS prompt.

If the target computer was previously started from the network boot image, to
disable the network boot capability, kill the boot server from Windows Task Manager.

2 Start the target computer by using network boot mode.
3 In the Command Window, change to the folder that contains the kernel and real-time

application files.
4 Copy these files to the root folder of the target computer C:\ drive:

tg = slrt;
SimulinkRealTime.copyFileToTarget(tg,'xpckrnl.rtb')
SimulinkRealTime.copyFileToTarget(tg,'ex_slrt_rt_osc.mldatx')
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5 Restart the target computer.

To boot the kernel and start the real-time application, the target computer executes
the following sequence of calls:

a C:\autoexec.bat
b C:\rttboot.com
c C:\xpckrnl.rtb
d C:\<application>.mldatx

Repeat this procedure for each target computer that you start in Stand Alone mode.

Continue by testing a real-time application in Stand Alone mode.

Application Transfer and Boot Configuration with Flash Drive

Note Speedgoat target machines come with DOS Loader software preinstalled.

You can set up the DOS Loader boot method on your development computer or configure
another boot method.

For more information about booting and kernel transfer, see your Speedgoat target
machine documentation or follow the link from “Speedgoat Target Computers and
Support”.

If the target computer does not support network boot mode, use a flash drive (USB) as a
boot device.

1 Restart the target computer in DOS mode and open the DOS prompt.
2 At the DOS prompt, save a copy of the target computer C:\autoexec.bat file to a

backup file, such as C:\autoexec_back.wrk.
3 Connect the flash drive to the development computer.
4 Copy these files to the root folder of the flash drive:

autoexec.bat
rttboot.com
xpckrnl.rtb
ex_slrt_rt_osc.mldatx
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5 Remove the flash drive from the development computer and connect it to the target
computer.

6 Restart the target computer.

To boot the kernel and start the real-time application, the target computer executes
the following sequence of calls:

a C:\autoexec.bat
b C:\rttboot.com
c C:\xpckrnl.rtb
d C:\<application>.mldatx

Repeat this procedure for each target computer that you start in Stand Alone mode.

Continue by testing a real-time application in Stand Alone mode.
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Standalone Mode
In Stand Alone mode, you can create control, DSP, and other system models for use in
production systems running on target computers. Typically these production systems are
manufactured in low to moderate quantities.

In Stand Alone mode, you can start the kernel and run the real-time application on the
target computer, independent of the development computer. You can configure a target
computer to start executing your real-time application automatically for continuous
operation each time the system is started. If the target computer has a keyboard, you can
control the real-time application using the target computer command-line interface. You
can create custom interfaces with the Simulink Real-Time C and .NET APIs and run them
on Microsoft Windows development computers, without installing MATLAB software.

Note Stand Alone mode does not require a connection between the development and
target computers.

Use this mode to load the target computer with both the Simulink Real-Time kernel and a
real-time application. This mode of operation can start the kernel on the target computer
from a flash disk or hard disk. After starting the kernel on the target computer, Stand
Alone mode also automatically starts the real-time application that you loaded with the
kernel. Stand Alone mode eliminates the need for a development computer and allows
you to run real-time applications on target computers.

Regardless of the mode, you initially start your target computer with DOS from a boot
device. DOS starts the Simulink Real-Time kernel. After the Simulink Real-Time kernel
starts, DOS is not available on the target computer. To make DOS available, you must
restart the target computer with DOS without starting the Simulink Real-Time kernel.

Simulink Real-Time standalone mode requires a boot device with DOS installed as
provided on all Speedgoat target machines. Otherwise, it does not have specific
requirements as to the type of boot device. DOS software and license are not included
with Simulink Real-Time. If DOS is not installed, first start the target computer from a
kernel boot disk or network boot image. Then, download and run the real-time
application.

If you use the target computer in a small or rugged environment, standalone mode is an
option if the target computer does not support network boot from the development
computer.
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If you want to view signals on the target computer in Stand Alone mode, you must
provide a monitor for the target computer. Before building the real-time application, you
must also add real-time Scope blocks of types target and file.

If you do not want to view signals on the target computer, you can run your Simulink
Real-Time system as a black box without a monitor or keyboard. Standalone real-time
applications are automatically set to continue running for an infinite time or until the
target computer is turned off.
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Run Confidence Test on Configuration
This topic describes how to test the target boot process, the connection between the
development and target computers, and the basic functionality of the Simulink Real-Time
software. Use this test under the following circumstances:

• To validate your initial product installation.
• As the first step in a troubleshooting procedure.

You must be using network boot mode for starting the target computer.

1 Create a network boot image and restart the target computer. See “Network Boot
Method” on page 2-17.

2 In the current folder window, select a folder outside the MATLAB root folder.

You cannot save build files within the MATLAB root folder because Simulink Coder
does not allow this action. If you select a current folder within the MATLAB tree, the
Simulink Real-Time test procedure fails when trying to build a real-time application.

3 In the Command Window, type slrttest.

MATLAB executes the test script for the default target computer and displays
messages indicating whether the test passed or failed.
### Simulink Real-Time Test Suite 
### Host-Target interface is: TcpIp
### Test 1, Ping target computer 'TargetPC1' using system ping: ... OK
### Test 2, Ping target computer 'TargetPC1' using SLRTPINGTARGET: ... OK
### Test 3, Software reboot the target computer 'TargetPC1': ........... OK
### Test 4, Build and download a Simulink Real-Time application using model ...
    slrttestmdl to target computer 'TargetPC1': ... OK
### Test 5, Check host-target command communications with 'TargetPC1': ... OK
### Test 6, Download a pre-built Simulink Real-Time application to target ...
    computer 'TargetPC1': ... OK
### Test 7, Execute the Simulink Real-Time application for 0.2s: ... OK
### Test 8, Upload logged data and compare with simulation results: ... OK
### Test Suite successfully finished

4 Evaluate the results.

• If the tests return OK, you are ready to build and download a real-time application
to the target computer.

• If one or more tests return FAILED, see “Troubleshooting in Simulink Real-Time”.

The next task is “Application and Driver Scripts” on page 4-38.

 Run Confidence Test on Configuration

2-29





Basic Workflows
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Real-Time Simulation and Testing
Real-time simulation and testing is used in two ways, differing only in whether the design
or the prototype is being modeled in software.

• Rapid control prototyping (RCP) — Model a design with software and connect it to
a physical system. In this way, you can work out the design flaws before investing in a
physical prototype and uncover requirements for new applications.

• Hardware-in-the-loop (HIL) simulation — Connect a physical prototype of the
design to a software plant model. In this way, you can test the prototype for safety and
performance without expensive downtime for the rest of the system. You can test
operation and failure conditions that are difficult to replicate and substitute for
unavailable parts of the system.

Basic Process Steps
Real-time simulation and test requires the following basic steps.

1 Create a Simulink or Stateflow® model.

Create block diagrams in Simulink by dragging blocks to your model. If possible, set
model and block parameters to use a fixed-step solver and specify a sample time
compatible with the real-time requirements of your model.

2 Simulate the model as a non-real-time application.

Simulink uses a computed time vector to step the model. After computing the outputs
for a given time value, Simulink immediately repeats the computation for the next
time value until it reaches the stop time.

Because the computed time vector is not connected to a physical clock, the outputs
are calculated as fast as your computer can run. The elapsed time of the simulation
can differ significantly from the elapsed time of the real system.

You can log simulation results for later comparison.
3 Configure the development and target computers.

Configure the communication method between the development and target
computers.

Configure the development and target computers using:
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• Simulink Real-Time Explorer
• “MATLAB Command-Line Interface” on page 1-5

4 Prepare the model for real-time execution.

Set the model Configuration Parameters to values compatible with real-time
execution:

• In the Code Generation pane, set System target file to slrt.tlc.
• In the Solver pane:

• Set Type to Fixed-step.
• Set Fixed-step size to a step size that is compatible with the real-time

requirements of your model.

Add Simulink Real-Time I/O blocks representing your I/O boards.

To visualize the simulation results, add real-time scope blocks. See “Add Simulink
Real-Time Scope Block” on page 4-8.

5 Configure the build environment.

To create a real-time application that runs on the target computer, configure the build
environment. The environment includes Simulink Coder options, Simulink Real-Time
build options, and C compiler options.

6 Connect to physical hardware.

Install I/O modules in the target computer and connect the modules to the physical
hardware.

7 Restart the target computer.

Restart the target computer with the Simulink Real-Time real-time kernel using:

• Target computer restart button.
• “MATLAB Command-Line Interface” on page 1-5

8 Build and download the real-time application.

Build and download the real-time application using:

• Simulink Real-Time Explorer (load and unload only)
• “MATLAB Command-Line Interface” on page 1-5
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• “Simulink External Mode Interface” on page 1-7
• “Target Computer Command-Line Interface” on page 1-9

9 Execute the real-time application.

Execute the real-time application under command from the development computer or
by restarting the target computer in standalone mode.

The Simulink Real-Time software uses real-time resources on the target computer.
Based on your sample rate, the Simulink Real-Time software uses interrupts to step
the model at the sample rate. With each new interrupt, the real-time application
computes the block outputs from your model.

Execute using:

• Simulink Real-Time Explorer
• “MATLAB Command-Line Interface” on page 1-5
• “Simulink External Mode Interface” on page 1-7
• “Target Computer Command-Line Interface” on page 1-9

10 Visualize signals.

Create real-time scopes and Simulink Real-Time Explorer instruments. Use them to
acquire and display signal data from the real-time application. You can filter and
group hierarchical signals in Explorer.

Scopes created by real-time scope blocks acquire data according to Simulink sample
time rules. Scopes can gather data at the top level or in an enabled or triggered
subsystem. Scopes created dynamically (from the MATLAB Command Window or the
API) sample at the base rate, irrespective of the sample time of their signals.

To create instrument panels, use Simulink Real-Time Explorer to create instrument
panels. You can drag graphical instruments to the instrument panels, and drag
signals to the instruments to display signal data.

Visualize signals using:

• Simulink Real-Time Explorer
• “MATLAB Command-Line Interface” on page 1-5
• “Simulink External Mode Interface” on page 1-7
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• “Simulink with Simulink Real-Time Blocks” on page 1-8
• “Target Computer Command-Line Interface” on page 1-9

11 Tune parameters.

Tune observable parameters such as time delays, input and output amplitudes, and
input and output frequencies. You can filter and group hierarchical signals in
Explorer.

Note  Simulink Real-Time does not support parameters of multiword data types.

Tune parameters using:

• Simulink Real-Time Explorer
• “MATLAB Command-Line Interface” on page 1-5
• “Simulink External Mode Interface” on page 1-7
• “Target Computer Command-Line Interface” on page 1-9

12 Prepare regression and stress tests.

Write MATLAB scripts that perform parameter sweep and extreme-value testing in a
repeatable manner, accumulating results as known good data.

Special-Purpose Tasks
In addition to the basic process steps, you can be required to perform other tasks:

• Visualize the model with Simulink Real-Time Explorer instruments.

Configure Simulink Real-Time Explorer with instrument panels configured with real-
time scopes and with signal display and parameter tuning graphical instruments.

• Run the model where the physical device runs.

Configure the real-time application to run outside MATLAB, for example in a moving
vehicle. Export the Simulink Real-Time Explorer configuration as a standalone control
program.

• Prepare regression and product tests with Simulink Test™.

Extend the regression and stress tests to cover functionality over the full parameter
range.
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• Integrate the model into a third-party test environment.

Use MATLAB Coder to translate MATLAB regression test scripts into C for integration
into a third-party test environment.

See Also

More About
• “Alternative Configuration and Control Methods” on page 1-3

3 Basic Workflows

3-6



Tutorial and Examples

This topic describes Simulink Real-Time functionality with a simple Simulink model
without I/O blocks. You can try these procedures without I/O modules on the target
computer. Once you are familiar with the setup, build, and target execution process, you
can try some of the more advanced Simulink Real-Time examples.

• “Set Up and Configure Simulink Real-Time” on page 4-2
• “Create and Run Real-Time Application from Simulink Model” on page 4-7
• “Apply Simulink Real-Time Model Template to Create Real-Time Application”

on page 4-21
• “Configure and Control a Real-Time Application” on page 4-24
• “Process a Real-Time Application with Simulink Real-Time Explorer” on page 4-29
• “Simulate Simulink Model with MATLAB Language” on page 4-31
• “Prepare Real-Time Application with MATLAB Language” on page 4-34
• “Execute Real-Time Application with MATLAB Language” on page 4-35
• “Application and Driver Scripts” on page 4-38
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Set Up and Configure Simulink Real-Time
You must have the following configuration:

• Single PCI bus target computer
• Network target computer boot method

You must have installed and configured a C compiler as part of Simulink Real-Time
installation. If not, see “Command-Line C Compiler Configuration”.

Configure Link Between Development and Target Computers
To run a Simulink Real-Time model on a target computer, you must connect the
development and target computers in a network.

The Target Network Settings values are representative only. Consult your network
administrator for actual values. For more on network configuration, see “PCI Bus
Ethernet Setup” on page 2-9.

1 In the Command Window, type slrtexplr.
2 In the Targets pane, expand the target computer node.
3 On the toolbar, click the Properties button .
4 In the Target Properties workspace, click Host-to-Target communication.
5 Under Target Network Settings, set values such as the following.

• IP address: 10.10.10.15
• Port: 22222
• Subnet mask: 255.255.255.0
• Gateway: 10.10.10.10

6 Under Ethernet Device Settings, set the following values:

• Target driver: Auto
• Bus type: PCI

7
Press Enter, then click the Save button  on the toolbar.

The dialog box looks like this figure.
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Note Support for using ISA bus Ethernet cards to communicate between the
development and target computers has ceased to function. Use PCI bus or USB bus
Ethernet cards instead.

Configure Target Settings
To run a Simulink Real-Time model on a target computer, you must configure the target
settings.

1 In the Command Window, type slrtexplr.
2 In the Targets pane, expand the target computer node.
3 On the toolbar, click the Properties button .
4 In the Target Properties workspace, click Target settings.
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5 Select USB Support, Multicore CPU, and Graphics mode.
6

Press Enter, then click the Save button  on the toolbar.

The dialog box looks like this figure.

Configure Boot Configuration
To run a Simulink Real-Time model on a target computer, you must configure the target
computer boot method. For more on boot methods, see “Target Computer Boot Methods”
on page 2-15.

1 In the Command Window, type slrtexplr.
2 In the Targets pane, expand the target computer node.
3 On the toolbar, click the Properties button .
4 In the Target Properties workspace, click Boot Configuration.
5 Select Boot mode Network.
6 Click Create boot disk.
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7
Press Enter, then click the Save button  on the toolbar.

The dialog box looks like this figure.

Run the Confidence Test
Validate the setup and configuration by running the confidence test.

1 Create a network boot image and restart the target computer. See “Network Boot
Method” on page 2-17.

2 In the current folder window, select a folder outside the MATLAB root folder.

You cannot save build files within the MATLAB root folder because Simulink Coder
does not allow this action. If you select a current folder within the MATLAB tree, the
Simulink Real-Time test procedure fails when trying to build a real-time application.
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3 In the Command Window, type slrttest.

MATLAB executes the test script for the default target computer and displays
messages indicating whether the test passed or failed.
### Simulink Real-Time Test Suite 
### Host-Target interface is: TcpIp
### Test 1, Ping target computer 'TargetPC1' using system ping: ... OK
### Test 2, Ping target computer 'TargetPC1' using SLRTPINGTARGET: ... OK
### Test 3, Software reboot the target computer 'TargetPC1': ........... OK
### Test 4, Build and download a Simulink Real-Time application using model ...
    slrttestmdl to target computer 'TargetPC1': ... OK
### Test 5, Check host-target command communications with 'TargetPC1': ... OK
### Test 6, Download a pre-built Simulink Real-Time application to target ...
    computer 'TargetPC1': ... OK
### Test 7, Execute the Simulink Real-Time application for 0.2s: ... OK
### Test 8, Upload logged data and compare with simulation results: ... OK
### Test Suite successfully finished

4 Evaluate the results.

• If the tests return OK, you are ready to build and download a real-time application
to the target computer.

• If one or more tests return FAILED, see “Troubleshooting in Simulink Real-Time”.

The next task is “Create and Run Real-Time Application from Simulink Model” on page 4-
7.
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Create and Run Real-Time Application from Simulink
Model

This tutorial begins with a non-real-time Simulink model of a damped oscillator,
ex_slrt_nrt_osc (open_system(docpath(fullfile(docroot, 'toolbox',
'xpc', 'examples', 'ex_slrt_nrt_osc')))). It assumes that you know how to
create, configure, and simulate such a model.

As you go through the tutorial, you transform ex_slrt_nrt_osc into a Simulink Real-
Time model configured to build as a real-time application. You then build, download, and
execute the real-time application on the target computer.

The final model is ex_slrt_rt_osc (open_system(docpath(fullfile(docroot,
'toolbox', 'xpc', 'examples', 'ex_slrt_rt_osc')))):
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Transform Simulink Model to Real-Time Application
To run a Simulink model as a real-time application under Simulink Real-Time, add and
configure a real-time Scope block and set configuration parameters for code generation
and target execution.

Add Simulink Real-Time Scope Block

Simulink Real-Time supports a real-time Scope block. There are three types of Simulink
Real-Time scopes: target, host, and file. This tutorial uses the target scope, which
displays execution data on the target computer monitor.

1 In the Command Window, type ex_slrt_nrt_osc.

MATLAB loads the oscillator model and displays the Simulink block diagram.
2 In Simulink Editor, from the View menu, click Library Browser.

The Simulink Library opens.
3 In the left pane, browse to and double-click node Simulink Real-Time.

A list of I/O block categories opens.
4 Click node Displays and Logging.
5 Click and drag block Scope to the Simulink block diagram.
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Simulink adds a new real-time Scope block to the model with a scope identifier of 1.
6 Connect the Mux output to the Scope block input.
7 From the File menu, click Save As. Enter a file name. For example, enter

ex_slrt_ucf_osc and then click OK.

The unconfigured model is ex_slrt_ucf_osc
(open_system(docpath(fullfile(docroot, 'toolbox', 'xpc',
'examples', 'ex_slrt_ucf_osc')))).

Set Target Scope Block Parameters

Scope block parameters define the signals to trace on the scope and trigger modes. The
Simulink Real-Time Scope block dialog box changes depending on which scope type you
are configuring: target, host, or file. For this tutorial, configure a target scope.

For more information about real-time target Scope parameters, see “Configure Real-
Time Target Scope Blocks”.

1 In the Command Window, type ex_slrt_ucf_osc.

MATLAB loads the oscillator model and displays the Simulink block diagram.
2 Double-click block Scope.
3 Select Scope type Target. This value means that the scope display appears on the

target computer monitor.
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4 In the block parameters dialog box, select the Start scope when application starts
check box.

This setting is mandatory in Stand Alone mode because the development computer
is not available to issue a command to start scopes.

5 Select Scope mode Graphical redraw.
6 Select the Grid check box.
7 Type [0,0] in the Y-axis limits text box. This value means that display scaling is

auto.
8 Type 1000 in the Number of samples text box. For a Scope mode of Graphical

redraw, this value means that 1000 samples are acquired before the graph is
redrawn.

9 Type 0 in the Number of pre/post samples text box. This value means that samples
are not saved before a trigger or skipped after a trigger.

10 Type 1 in the Decimation text box. This value means that data is collected at each
sample interval.

11 Select Trigger mode FreeRun. This value means that the trigger event is automatic
and no external trigger specification is required.

The target scope dialog box looks like this figure.
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12 Click OK.
13 From the File menu, click Save.

Set Configuration Parameters

The example model, ex_slrt_ucf_osc, is a non-real-time model of a damped oscillator.
You enter the simulation and real-time run parameters in the Configuration Parameters
dialog box. These parameters give information to Simulink Coder on how to build the real-
time application from the Simulink model.

After you open a Simulink model and start the target computer, you can enter the
simulation parameters.

1 In the Command Window, type ex_slrt_ucf_osc.
2 In Simulink Editor, click Simulation > Model Configuration Parameters.
3 In the Configuration Parameters dialog box, click the Solver node.
4 In the Solver selection section, from the Type list, select Fixed-step.
5 From the Solver list, select a solver. For example, select the general-purpose solver

ode4 (Runge-Kutta).
6 Under Solver details, in the Fixed-step size (fundamental sample time) box,

enter the sample time for the real-time application. For example, enter 0.00025
seconds (250 microseconds). You can change this value after creating the real-time
application.

If you find that a value overloads the CPU on the target computer, try a larger Fixed-
step size value, such as 0.0002 seconds.

The sample times of the model blocks can only be multiples of Fixed-step size. If you
enter 'auto' in Fixed-step size, the fundamental sample time is calculated from the
sample times of the model blocks.
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7 In the Configuration Parameters dialog box, click the Code Generation node.

The code generation pane opens.
8 To build a basic real-time application, in the Target selection section, click Browse

at the System target file list. Click slrt.tlc, and then click OK.

The system target file slrt.tlc, the template makefile slrt_default_tmf, and
the make command make_rtw are automatically entered into the page. The
Simulink Real-Time Options node appears in the left pane.
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9 Click OK.
10 From the File menu, click Save As.

Enter a file name. For example, enter ex_slrt_rt_osc
(open_system(docpath(fullfile(docroot, 'toolbox', 'xpc',
'examples', 'ex_slrt_rt_osc')))).
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Start Target Computer
Starting the target computer loads and starts the Simulink Real-Time kernel on the target
computer. The loader then waits for the Simulink Real-Time software to download the
real-time application from the development computer.

After you have configured the Simulink Real-Time product using the Simulink Real-Time
Explorer and created a target boot disk for that setup, you can start the target computer.
Before building the real-time application, you must start the target computer because the
build process automatically downloads the real-time application to the target computer.
Be sure that you have followed the instructions from “System Configuration”.

1 Insert the target boot disk into the target computer disk drive.
2 Turn on the target computer or press the Reset button.

The target computer displays a screen like this screen.
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If you have a keyboard attached to the target computer, you can activate that
keyboard by typing C. Press the Page Up and Page Down keys to page up and down
in the target computer monitor.

The status window shows that the kernel is in loader mode and waiting to load a real-time
application. The memory value is the number of bytes of target computer memory
available for the heap, for running scopes, and for data acquisition buffers.
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Note Target computer memory for the real-time application executable, the kernel, and
other uses is limited to a maximum of 4 GB.

Build and Download Real-Time Application
The example model is a real-time model of a damped oscillator, ex_slrt_rt_osc
(open_system(docpath(fullfile(docroot, 'toolbox', 'xpc', 'examples',
'ex_slrt_rt_osc')))). You use the Simulink Real-Time build process to generate C
code, compile, link, and download the real-time application to the target computer.

After you enter changes in the Configuration Parameters dialog box, you can build the
real-time application. By default, the build procedure downloads the real-time application
to the default target computer, as designated in Simulink Real-Time Explorer. For further
details on setting the target computer for a real-time application, see “Simulink Real-Time
Options Pane”.

1 In the Command Window, type ex_slrt_rt_osc.

MATLAB loads the oscillator model and displays the Simulink block diagram.
2 In Simulink Editor, on the toolbar, click the Build Model button  on the toolbar.

On the development computer, after completing a build without detecting an error,
MATLAB displays lines like the following:

### Starting Simulink Real-Time build procedure for model: 
ex_slrt_rt_osc
. . .
### Successful completion of Simulink Real-Time build procedure for 
model: ex_slrt_rt_osc

After compiling, linking, and downloading the real-time application, Simulink Real-
Time creates a target object in the MATLAB workspace. The default name of the
target object is tg. For more information about the target object, see “Real-Time
Application Objects”.

If you have a monitor connected to your target computer, the monitor screen looks
like this screen.
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3 In the Command Window, type:

tg

MATLAB displays a list of properties for the target object tg.

If the software detects an error during build and download, see “Troubleshooting in
Simulink Real-Time”.
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If you download a real-time application built with a Simulink Real-Time version different
from the version of the kernel on the target computer, the software prints an error:

Mismatch between model and kernel versions

To prevent this version mismatch, rebuild real-time applications with each new Simulink
Real-Time release.

During the build process, the Simulink Real-Time software creates a target object that
represents the real-time application running on the target computer. You control the real-
time application and computer by setting the target object properties and calling target
object functions. For a list of these functions, such as load, see
SimulinkRealTime.target.

Execute Real-Time Application with Simulink External Mode
Control of the real-time application with Simulink is limited to connecting a Simulink
model to a real-time application through external mode, and then starting the real-time
application. Using Simulink external mode is one method to tune parameters. By default,
the model connects to the default target computer, as specified in Simulink Real-Time
Explorer.

Note Do not use Simulink external mode while Simulink Real-Time Explorer is running.
Use only one interface or the other.

After you build and download a real-time application to the target computer, you can run
the real-time application. This procedure uses the Simulink model ex_slrt_rt_osc
(open_system(docpath(fullfile(docroot, 'toolbox', 'xpc', 'examples',
'ex_slrt_rt_osc')))). See “Build and Download Real-Time Application” on page 4-17.
You must already have specified the required target computer environment on the
Simulink Real-Time Options node of the Simulink Real-Time parameters dialog box. In
particular, you must specify the target computer to which you want to connect. See the
Build for default target computer check box description in “Simulink Real-Time
Options Pane”.

1 Select Simulation > Mode > External.

A check mark appears next to the menu item External. Simulink external mode is
activated. Simulink external mode connects the Simulink model to the real-time
application as a simple user interface.
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2
On the toolbar, click the Connect To Target button .

The current Simulink model parameters are downloaded from the development
computer to the real-time application.

3
On the toolbar, click the Run button .

The real-time application begins running. The Simulink Scope block show output like
the figure.

4
To stop execution, on the toolbar, click the Stop button .

See Also
Mux | Scope | Scope | SimulinkRealTime.target | load | viewTargetScreen
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Apply Simulink Real-Time Model Template to Create
Real-Time Application

This example shows how to use the Simulink Real-Time template for a new Simulink
model. Starting from the model template for Simulink Real-Time provides a new model
that has configuration parameters set up for building a real-time application.

To see the Simulink Real-Time commands for each operation in this example, view the
example code.

Create a Simulink Model from Template

Create a new Simulink model from the Simulink Real-Time model template.

To create this model from the Simulink start page, in the Command Window, type:

simulink

Select the Simulink Real-Time template from the start page, and create the
exampleSlrtApp model. Or, in the Command Window, use the
Simulink.createFromTemplate command.

Add Blocks, Connections, and Data Logging to the Model

The Simulink Real-Time model template contains a gain block that connects an inport to
an outport. To make this model produce more interesting data to view on a target scope
and to view with the simulation data inspector (SDI), add these blocks and connections.
You can use the UI for these steps or use the script commands shown:

• Add a signal generator by using the add_block command. Use the set_param
command to set its Amplitude parameter value to 4 and set its Frequency parameter
value to 400.
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• Add a target scope by using the add_block command.
• Remove the connections between the Gain block, inport, and outport by using the

delete_line command.
• Connect the signal generator to the gain block input by using the add_line

command.
• Connect the gain block output to the target scope by using the add_line command.
• Mark the Gain block output for data logging by using the set_param command.

Build the Real-Time Application and View Logged Data

You are ready to build the real-time application, run it on the target computer, and view
the logged data with these steps:

• Make sure that the development computer has a connection to the target computer.
• Build the model and download the real-time application to the target computer by

clicking the Build button or by using the rtwbuild command.
• Run the real-time application and log data by using the start command.
• Open SDI by double-clicking the simulation data inspector icon on the Gain block

output signal or by using the Simulink.sdi.view command.

More Information

• “Create and Run Real-Time Application from Simulink Model” on page 4-7
• “Configure and Control a Real-Time Application” on page 4-24
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• Simulation Data Inspector
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Configure and Control a Real-Time Application
You can configure and control a real-time application using the Simulink Real-Time
Explorer and Simulink external mode. This tutorial focuses on interaction using Simulink
Real-Time Explorer. The model is a real-time model of a damped oscillator,
ex_slrt_rt_osc (open_system(docpath(fullfile(docroot, 'toolbox',
'xpc', 'examples', 'ex_slrt_rt_osc')))).

Execute Real-Time Application with Simulink Real-Time
Explorer
To perform this procedure, you must have already created a Simulink Real-Time boot disk
and started the target computer. See “Start Target Computer” on page 4-15). This
procedure begins with the real-time application ex_slrt_rt_osc
(open_system(docpath(fullfile(docroot, 'toolbox', 'xpc', 'examples', 'ex_slrt_rt_osc'))))
already downloaded to the target computer. See “Build and Download Real-Time
Application” on page 4-17.

1 In the Simulink Editor, click Tools > Simulink Real-Time.
2 In the Targets pane, click the target computer icon for which you have downloaded

the real-time application and click the Connect button  on the toolbar.

The target computer icon turns to Connected .
3 In the Applications pane, select the real-time application.
4 To start execution, click the real-time application and click the Start button  on the

toolbar.

The application starts running. The dialog box looks like this figure.
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If you have a monitor connected to your target computer, you can view output that
looks like this output.
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5 To stop execution, click the real-time application and click the Stop button  on the
toolbar.

The real-time application on the target computer stops running. The target computer
displays messages like these messages.

minimal TET: 0.0000006 at time 0.001250
maximal TET: 0.0000013 at time 75.405500
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Alternatively, you can use functions in the MATLAB Command Window to start and stop
the real-time application. For more information about these functions, such as load, see
SimulinkRealTime.target.

Change Stop Time and Sample Time
This procedure is for changing the stop time and sample time in the real-time application
configuration. You must have already downloaded the real-time application
ex_slrt_rt_osc (open_system(docpath(fullfile(docroot, 'toolbox',
'xpc', 'examples', 'ex_slrt_rt_osc')))) to a target computer.

1 In Simulink Real-Time Explorer, expand the node of the loaded real-time application
in the Applications pane.

2 On the toolbar, click the Properties button .
3 In the Application Configuration workspace, under the Properties arrow, enter a

new value for Stop time. For example, enter inf and press Enter.

The real-time application now runs until you stop it.
4 Enter a new value for Sample Time. For example, enter 0.00010 and press Enter.

Note Some blocks produce incorrect results when you change their sample time at
run time. If you include such blocks in your model, the software displays a warning
message during model build. To avoid incorrect results, change the sample time in
the original model, and then rebuild and download the model.

5 To start execution, click the real-time application and click the Start button  on the
toolbar.

6 To stop execution, click the real-time application and click the Stop button  on the
toolbar.

The dialog box looks like this figure.
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If you specify a sample time that is too small, a CPU overload can occur. If a CPU overload
occurs, the target object property CPUOverload changes to detected. In that case,
change Fixed step size to a larger value and rebuild the model.

See Also
Scope | viewTargetScreen

More About
• “Create Target Scopes with Simulink Real-Time Explorer”
• “Log Signal Data with Outport Blocks and Simulink Real-Time Explorer”
• “Blocks Whose Outputs Depend on Inherited Sample Time” (Simulink)
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Process a Real-Time Application with Simulink Real-Time
Explorer

You can create a real-time application for later downloading

1 In Simulink Editor, click Simulation > Model Configuration Parameters.
2 Under the Code Generation node, select the Simulink Real-Time Options node.
3 Clear the Automatically download application after building check box.
4 From the Code menu, click C/C++ Code > Build Model.

Load a Preexisting Real-Time Application
After you have built a real-time application, you can load it from the build folder.

1 In MATLAB, navigate to the build folder.
2 In the Simulink Editor, click Tools > Simulink Real-Time.
3 In the Targets pane, click the required target computer icon and click the Connect

button  on the toolbar.

The target computer icon turns Connected .
4 Do one of the following:

• From the Command Window or from Microsoft Windows, drag the prebuilt real-
time application DLM file to the target computer icon.

• Right-click the required target computer icon and click Load. The DLM
Application Selector dialog box opens. Enter or browse to the prebuilt
application DLM file.

Unload a Real-Time Application
To remove a real-time application from the target computer:

1 In the Simulink Editor, click Tools > Simulink Real-Time.
2 Right-click the required target computer icon and click Unload.
3 In the Targets pane, click the required target computer icon and click the

Disconnect button  on the toolbar.
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The target computer icon turns Disconnected .
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Simulate Simulink Model with MATLAB Language
Run a simulation of the Simulink model to observe the non-real-time behavior of the
model.

After you load the Simulink model into the MATLAB workspace, you can run a simulation.
This procedure uses the Simulink model ex_slrt_nrt_osc
(open_system(docpath(fullfile(docroot, 'toolbox', 'xpc', 'examples',
'ex_slrt_nrt_osc')))). You must have loaded this model and entered the MATLAB
variables tout and yout in the Data I/O pane in the Configuration Parameters dialog
box.

1 In the Command Window, type:

output=sim('ex_slrt_nrt_osc','SimulationMode','normal');

The signal from the signal generator is logged to memory through the Outport block.

Simulink runs a simulation in normal mode through to completion. You cannot
manually stop the simulation. For further information on the sim command, see the
Simulink documentation.

2 After Simulink finishes the simulation, type:

plot(output.get('tout'), output.get('yout'))

MATLAB opens a plot window and displays the output response as shown in this
figure.
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When the real-time application is running in Real-Time mode, data is not saved to the
variables tout and yout. Instead, data is saved in the target computer memory and can
be retrieved through the target object properties tg.TimeLog, tg.StateLog, and
tg.OutLog. However, in the Configuration Parameters dialog box, you must still select
the Time, States, and Output check boxes for data to be logged to the target object
properties.
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See Also
Outport
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Prepare Real-Time Application with MATLAB Language
You can configure your real-time application using MATLAB language and build and
download it to the target computer. This example uses the ex_slrt_rt_osc
(open_system(docpath(fullfile(docroot, 'toolbox', 'xpc', 'examples',
'ex_slrt_rt_osc')))). It assumes that the default target computer is configured for
network boot mode and that communication has been established.

1 Check that the connection to the target computer is functioning.

slrtpingtarget
2 Load the model.

model_name = 'ex_slrt_rt_osc';
open_system(model_name);

3 Set the start and stop time parameters.

set_param(model_name,'StartTime','0');
set_param(model_name,'StopTime','10');

4 Build and download the model.

rtwbuild(model_name);
pause(30);

5 Assign tg to the target computer.

tg = slrt;

The next step is to execute the real-time application. See “Execute Real-Time Application
with MATLAB Language” on page 4-35.
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Execute Real-Time Application with MATLAB Language
Run the real-time application with generated code to observe the real-time behavior of
the model. This procedure uses the Simulink model ex_slrt_rt_osc
(open_system(docpath(fullfile(docroot, 'toolbox', 'xpc', 'examples',
'ex_slrt_rt_osc')))). You must have already carried out the steps in “Prepare Real-
Time Application with MATLAB Language” on page 4-34.

This example uses functions in the MATLAB Command Window to start and stop the real-
time application. For more information about these functions, such as load, see
SimulinkRealTime.target.

1 In the Command Window, type:

start(tg)

The real-time application starts running on the target computer. In the Command
Window, the status of the target object changes from stopped to running.

Target: TargetPC1
        Connected             = Yes
        Application             = ex_slrt_rt_osc
        Mode             = Real-Time Single-Tasking
        Status             = running

2 On the target computer screen, the Execution line changes from stopped to running.
The AverageTET line is periodically updated with a new value.

 Execute Real-Time Application with MATLAB Language

4-35



3 In the Command Window, type:

stop(tg)

The real-time application stops running.

The Simulink Real-Time software allows you to change many properties and
parameters without rebuilding the real-time application. Two of these properties are
StopTime and SampleTime.
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4 Change the stop time. For example, to change the stop time to 1000 seconds, type:

tg.StopTime = 1000
5 Change the sample time. For example, to change the sample time to 0.01 seconds,

type:

tg.SampleTime = 0.01

Note Some blocks produce incorrect results when you change their sample time at run
time. If you include such blocks in your model, the software displays a warning message
during model build. To avoid incorrect results, change the sample time in the original
model, and then rebuild and download the model.

If you specify a sample time that is too small, a CPU overload can occur. If a CPU overload
occurs, the target object property CPUOverload changes to detected. In that case,
change Fixed step size to a larger value and rebuild the model.

See Also
viewTargetScreen

More About
• “Blocks Whose Outputs Depend on Inherited Sample Time” (Simulink)
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Application and Driver Scripts
The Simulink Real-Time examples show the features of the Simulink Real-Time product.
They are also scripts that you can use as a starting point for writing your own scripts for
creating and testing real-time applications.

Examples include general applications examples and driver examples. You can access the
general application and driver examples through MATLAB Help. In the help window, click
Simulink Real-Time > Demos to see the available example categories.

General Examples
The general application examples include models and scripts showing:

Description File Name
Real-time parameter tuning and data logging “Parameter Tuning and Data

Logging”
Freerun display mode of a host scope “Signal Tracing With a Host

Scope in Freerun Mode”
A software-triggered host scope “Signal Tracing Using

Software Triggering”
A signal-triggered host scope “Signal Tracing Using Signal

Triggering”
A scope-triggered host scope “Signal Tracing Using Scope

Triggering”
Signal tracing with a target scope “Signal Tracing With a Target

Scope”
Pre- and post-triggering of a host scope “Pre- and Post-Triggering of a

Host Scope”
Time- and value-equidistant data logging “Time- and Value-Equidistant

Data Logging”
Logging signal data with the Simulation Data Inspector
to a file on the development computer

“Data Logging With Simulation
Data Inspector (SDI)”
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Description File Name
Frame signal processing

Note This example requires DSP System Toolbox™
software.

“Frame Signal Processing”

Simulink Real-Time software as a real-time spectrum
analyzer

“Spectrum Analyzer”

Creating a custom client application to interface with
the target computer

“Simple Client Application
With the .NET API”

Concurrent execution of a model using the Simulink
Real-Time profiling tool

“Concurrent Execution on
Simulink® Real-Time™”

Driver Examples
These driver examples include models and scripts showing the use of driver blocks in a
Simulink Real-Time environment. Running some of these examples requires you to install
specific hardware.

• Analog and digital I/O
• ARINC 429
• Asynchronous events
• Audio
• CAN (CAN_MESSAGE data types)
• Counters, timers, pulse width modulators (PWM)
• Digital signal processing
• Encoders
• EtherCAT
• FPGA
• J1939
• MIL-STD-1553
• Precision Time Protocol (PTP)
• Raw Ethernet
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• RS-232
• Shared/reflective memory
• UDP
• Video

Edit Scripts
To locate and edit an example such as “Signal Tracing With a Host Scope in Freerun
Mode”:

1 Follow the link to the example and determine its MATLAB file name, in this case
scfreerundemo.

2 In the Command Window, type:

which scfreerundemo

MATLAB displays the location of the MATLAB example file.

C:\MATLAB\toolbox\rtw\targets\xpc\xpcdemos\scfreerundemo.m
3 Type:

edit scfreerundemo

MATLAB opens the file in the MATLAB Editor.
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